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1.

INTRODUCTION
This document covers the operation of the Model 108 MkIII and Model 308 Current Meters, when used
with DataLog PC software. DataLog software is also compatible with other Valeport instruments, so the
user may find functions that are unavailable with this instrument. These functions are for use with other
Valeport instruments only, and are not covered in this manual.

1.1

DESCRIPTION

DataLog is an event driven program written in VISUAL BASIC FOR WINDOWS for use with Valeport data
gathering instruments. The program allows the user to configure the sampling regime of the instruments,
view data in real time using a selection of displays, and extract and view data from logging instruments.
Available displays include real time only displays for measured and calculated parameters (if applicable)
tabulated scroll, and graphical output. The user can select suitable scales for the graphical displays.
Additional features of DataLog include:
•
•
•
•

Recording of real time data to PC.
Printing of data (tabulated scroll and graphs).
Test Formula function to allow data checks.
Simple statistical analysis of data.
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2

INSTALLATION

2.1

INSTALLING DATALOG

It is recommended that an IBM compatible PC of 486 DX2 level or above is used, with Windows 3.1 or
above. It is advisable to have at least 8Mb RAM fitted; software will operate with a standard 4Mb, but
opening too many windows may cause system to "hang up".

To install DataLog follow the procedures as described below.

To install DataLog follow the procedures as described below.
•

Place the installation Disk 1 in drive A.

•

In Windows 95 select Run in the Startup Menu

•

In the command line type A:SETUP followed by <CR>.

•

Insert Disk 2 when requested.

•

After a few seconds you will be asked to select the path and directory in which to install DataLog.

•

Select Continue to select default DataLog directory.

The installation will now commence. When finished an OK prompt will appear with the message
INSTALLATION IS COMPLETE. The DataLog program is now available for use under the Program
Manager.

2.2

PC SETUP
In order for DataLog to operate correctly, the format of the date, time and numbers must be correctly set
within the Windows Control Panel.

Function
Date
Time
Numbers:

Decimal Mark
Thousands separator

Format
dd/MM/yy
HH:mm:ss (24 hr clock)
.
,

Example
23/09/96
16:37:20
1.25
1,321,000

Failure to set the above parameters correctly may result in the software being unable to
read data from the instrument.
Flow charts on the next two pages indicate the principle steps in operating the instruments in Direct
Reading and Self Recording (Model 308 only) modes. For more detailed explanations and instructions
please refer to Sections 3 & 4.
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FIGURE 1

OPERATION OF 308 IN LOGGING MODE
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FIGURE 2

OPERATION OF 108 MKIII & 308 IN DIRECT READING MODE
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3

SETUP
In order to operate the unit, the first step is to correctly configure it using the Setup pull down menu in the
opening DataLog screen.
This menu contains all controls necessary for communication with the instrument, setup of sampling
regime, and data extraction.

3.1

PORT
Communications are via RS232 comms port. It is necessary to set the comms port configuration before
any communications can be achieved. Do this by selecting Port from the Setup menu. The following
display will be shown:

Select the correct comms port number using the mouse. Note that the default baud rate is 4800. For
reference, the communications are pre-set to 8 data bits, 1 stop bit and no parity; these are not user
changeable.
If the user intends to use the Current Meter in Direct Reading mode over long cable lengths, there is a
factory fit option to communicate using RS485 rather than RS232. If this option is fitted to the instrument,
communications must be via the RS485 adaptor supplied, and the RS485 box in the above display must be
checked.
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3.2

CONNECT
Having correctly configured the comms port, it is possible to communicate with the instrument.
Select Connect from the Setup menu.
A Dialog box similar to that shown below will appear. Confirmed in the title block are the instrument type
(in this case, Model 308) and the serial number of the unit (16509). This box allows changes to be made
to the unit's setup. The different options are detailed below.
NOTE: If the Set command is not implemented, the changes will not be made in the instrument.

It is also possible to return to Connect stage from Run mode, if changes need to be implemented. Run
mode must then be reselected once changes have been set.
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3.3

PROBE CONFIGURATION (308 ONLY)
The amount of total memory and the amount available for recording data is shown together with the
instrument date/time. In the above example, the unit has a total of 131,072 bytes of which 130,072 are
unused. The user may also enter text under 'Header', to provide information about the instrument or the
deployment for later reference.

3.4

SAMPLE MODE
The only sample mode available on the Model 108 MkIII and Model 308 Current Meters is TIME sampling.
The instruments operate on a minimum five second cycle, during which they measure the average speed
of the flow, and take a single compass reading. The length of this cycle can be set by the user to any
multiple of 5 seconds, using the Sample Period box. For example, entering 12 in this box will set the
sampling cycle to 12 x 5 seconds, i.e. 60 seconds. This means that the unit will measure the average flow
over one minute, and then take a single compass reading to provide direction of that flow.
The user is also required to set the Average Period. This is set by the user to be the number of Sample
Periods over which the data is averaged. Continuing the above example, setting an Average Period of 10
means that the data will be averaged every 10 Sample Periods, i.e. every 10 minutes.

The only data that is displayed or logged is the average value obtained at the end of the Average Period.
If the user wishes to log every sample taken, Average Period must be set to 1.

3.5

MODE
The Modes available will depend upon the instrument type. If the unit is a Model 308, it will have Direct
Reading, Self Recording or Both options. If the unit is a Model 108 MkIII, only Direct Reading is available.
In all cases however, it is possible to record Direct Reading data to disk. See Section 4.1 for details of how
to do this.
i) Dir

This is Direct reading where the data is transmitted in real time mode in intervals
defined by the sampling setup.

ii) Log

This Logging mode stores averaged data in the instrument RAM in intervals defined by
the sampling setup. No data will be transmitted in this mode.

iii) Dir & Log

This mode performs i) and ii) i.e. real time data is transmitted and stored to internal RAM.

Select the desired operating mode by clicking on the relevant option with the mouse.
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3.6

PRESSURE TARE SETTING (IF FITTED)
The Model 108 MKIII and Model 308 can have a pressure sensor fitted as an option. All pressure
measurements are related to absolute. Prior to deployment the tare pressure can be set. To set the current
tare pressure, select Pressure in the Sensor Configuration window. The current calibration and pressure
tare will be displayed. Select Set Tare; the instrument will read the current absolute pressure and then
adjust all subsequent pressure readings by this amount so they are referenced to the sea level pressure at
the time of deployment.

3.7

OTHER PARAMETER INFORMATION
Similar Dialog boxes will appear for the other optional sensors (Temperature and Conductivity), showing
the current calibration details. These cannot be altered in DataLog. For details of how to change
calibration data, refer to the main Unit Operation Manual.
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3.8

MISCELLANEOUS

3.8.1

BAUD RATE
When uploading data, the baud rate limits the time taken. To speed the transfer process up, the baud may
be changed to a higher rate than the standard 4800. It must be stressed that the cable lengths and the type
of communications being used may restrict the maximum baud rate. If an upload error occurs, reduce the
baud rate and retry.
For example, if using a short 'Y' lead to set up the instrument or extract data, 19200 should be acceptable
assuming the PC in use can support this. When using very long cable lengths with current loop
communications for example, the data rate may need to be slowed down to 1200 baud for successful
protocol.
It should be noted, however, that the instrument will always start at 4800 baud from switch on.

3.8.2

SET SPEED OF SOUND FORMULA
If the parameters of Conductivity, Temperature and Depth are fitted, DataLog calculates the additional
parameters of Density Anomaly, Salinity and Speed of Sound. Many formulae have been put forward over
the years for calculating Speed of Sound, and opinion varies as to which is the best. It is generally
accepted that Chen & Millero (1977) is the most accurate for depth ranges over which Valeport units
operate, and for this reason, this is the formula that is used as default. However, DataLog gives the user
the option to use a different formula for calculating Speed of Sound, if it is deemed necessary. To change
formula, click the Set Speed of Sound button at the bottom right of the Setup screen, and the various
options are displayed. If any formula other than Chen & Millero is selected, the user is asked to input the
geographical latitude at which the unit is to be used. See Appendix 1.3 for an explanation of this, full
details of each formula, and a short discussion on the merits of each.

3.9

LOGGED DATA
The user also has the option to Upload Logged Data from a Model 308. Full details on how to do this are
given in Section 5.1.

3.9.1

CLEAR FILES
Click on this button to Erase the memory of a Model 308. A confirmation is displayed, and clicking on OK
erases memory.
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4

RUN MODE

4.1

RUNNING THE INSTRUMENT
After all the instrument configurations have been set as required, it is possible to begin the sampling
program. If the you are using the meter in Direct Reading or Both Mode, this is achieved by selecting Run
from the Setup menu. The unit enters an interrupt period for 15 seconds, during which the message
Initialising is displayed in the bottom left hand corner of the Window. Following this, the unit enters Run
mode.
If you are using a Model 308 in Logging Mode only, YOU MUST REMOVE THE 3m 'Y' LEAD USED FOR
SETTING UP THE UNIT AND FIT THE LED CAP to the fish after having set the desired configuration at the
Connect Screen. Fitting the cap automatically sets the unit into Run Mode, as above, after a 15 second
period during which the LED cap flashes.
To see real time Direct Reading data, use one of the display modes detailed in Section 5, by selecting the
appropriate command from the Display pull down menu.

4.2

RECORD
It is possible for Direct Reading data to be recorded on computer disk. After the desired configuration has
been set in the Connect Screen, select Record from the File pull down menu. You will be asked to specify
a drive, directory and file name for the record. Then proceed to run the unit as above. The data will
automatically be recorded as it is produced.
In order to view direct reading data, you must select a display mode from the Display pull down menu.
Full details on these modes are in Section 5.3.

4.3

STOP
To stop the unit Running in Direct Reading or Both modes, select Stop from the Setup pull down menu.
The unit will also stop if Connect is selected, or if the LED cap is removed in Logging mode. The unit must
be stopped in order to allow certain functions to be used in the displaying of data. See Section 5 for
further details.
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5

DATA HANDLING

5.1

UPLOADING LOGGED DATA (MODEL 308 ONLY)
Data are stored in internal battery backed RAM in binary format. Each time the unit is switched on or
'RUN', a new data file is created with its own header information containing averaging period, etc.
following which the data is recorded. These data files can be uploaded and saved to disk by selecting
Upload from the Connect screen in Setup. A binary file is created initially which mirrors the requested
stored data files; the default name is RAW.
Calibrated files (default name CAL) are created from the binary files.
The Calibrated files can later be displayed in the various formats available with this package or imported
into spreadsheets for statistical analysis.
The Display will now show the following:
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i) Data Areas:

Scrollable text box containing file allocation within the instrument. If no data
has been stored in the instrument, the message 'Nothing to upload' will be
displayed.

ii) Raw filename:

Binary format files in non engineering units. The default filename RAW may
be changed; it should be restricted to 8 characters.

iii) Calibrated filename:

Calibrated files generated from RAW binary files. The default filename CAL
may be changed; it should be restricted to 8 characters.

iv) Data directory

Standard type Dialog box to allow alternative directory paths to be set. The
default path is c:\datalog.

A header file is created as default, which contains various pieces of information about the file, with the
following structure. To override this, select make Separate Header File.

File header created by DataLog on 18/09/96 16:33:54
Device: BFM308, Serial number: 16509
Header text: VALEPORT 108/308
Mode: TIME_SAMPLE
Sample period (x5 secs): 3, Average period: 1
Impeller coefficients: 17 +1.4143845e-19 -3.5458315e-11 +2.4820728e-09 -5.5286880e-10
-4.8346085e-06 +1.6050182e-04 +5.6165843e-02 +1.7216420e-0
Speed of sound formula Chen & Millero

As many files as you want can be selected at once with the mouse by holding down Ctrl while using the
mouse to click on each file. Once the desired files have been highlighted, select Upload. Initially the
RAW binary files will be created with an extension relating to file number, e.g. RAW.005 corresponds to
file number 5 in the instrument. The Calibrated data files are created using the same extension as the
binary files from which they were created.
Note that the data in the instrument is not erased after uploading, further logging will occur after the last
record.

5.2

SAVED DATA
If you wish to look at data already on the computer, either Uploaded from a self recording unit or recorded
from Direct Reading mode, select Open from the File menu. Select the desired drive, directory and file
and push Enter. The correct file will then be opened.
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5.3

DISPLAYS
Data from the unit can be displayed in 5 formats. Several different displays can be shown simultaneously
and iconized.

For Direct Reading Display
5.3.1

BRIEF
The Brief display will show the parameters transmitted by the instrument in real time mode only. It should
be noted that data will only be updated at the end of an averaging period. Data stored on disk cannot be
displayed in this format.
This display is not sizeable, but can be iconized and moved outside the DataLog environment.
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5.3.2 FULL
The Full display is also only available in real-time mode, and offers the parameters as shown below. The
Salinity, Density Anomaly and Sound Speed are calculated by DataLog (if Conductivity, Temperature and
Pressure Sensors are fitted) and not by the instrument. Parameters which are not fitted to the instrument are
shown in italics and not updated. This display is not sizeable, but can be iconized and moved outside the
DataLog environment.
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5.3.3

SCROLL
As the title suggests, a Scrolled display will be shown as below. The most recent data will be displayed at
the top therefore scrolling data down. To view information outside the text box, shift the display using the
arrow controls with the mouse. Unlike the Brief and Full display options, data previously stored from real
time recording (see sections 4.1 & 5.2) or Uploaded from the instrument (see section 5.1) can be recalled
and displayed in this format. The example below shows a typical scrolled display of recorded data.

Data displayed in this format can be printed, but not while the unit is actually running. If this screen is
being used for real time display, Stop or Connect must be selected to allow data printing. To print off a
table of data, select Print from the Options Menu. A standard Windows Print Options form will be
displayed.
It is also possible to select the font in which the data is to be printed. Selecting Set Print Font before
selecting the Print function reveals a display showing all available printer fonts. NB Some TrueType fonts
will not size to the page correctly, so use of these is not recommended.

5.3.3.1 AVERAGE DATA
A display of average data values can be obtained from this screen. While the unit is stopped (or with
recorded/uploaded data), the Scroll table has the property of allowing values within the table to be
highlighted. This can be done either by dragging the mouse over the desired values, or by clicking on a
column header to select the entire column. Then select Data Analysis from the Display menu. A table
will be displayed, showing high and low values, the mean value of the data, and the Standard Deviation of
the data.
NOTE: It is not possible to perform Data Analysis on more than one parameter at once.
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5.3.4

GRAPH
The Graphical display function can be used for either real time or recorded data, and allows each
parameter from the instrument to be displayed as a function of time or pressure. The outputs provided
show the parameter type by way of engineering units; the 'Y' axes can be scaled individually but the 'X'
axis can only be scaled for all parameters within each graph. To select more than one parameter for
display on the same graph, use Ctrl and the mouse to click on each in the Dialog box. Several individual
graphs can be displayed at once, the limitations of which would depend upon PC configuration and the
number of tasks running in the WINDOWS environment, such as statistical analysis packages, word
processor, etc.
Graphical representation can be made of any of the parameters from an instrument in real time mode once
the connection has been established. Each graph may be iconized, but will still be refreshed as new data
appears. A hard copy of the plot can be produced by selecting the pull down menu Files and selecting
Print which will then show a standard type Dialog box from which print resolution, number of copies, etc.
can be chosen.
A typical graph is shown below as a function of Time.
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5.3.4.1 GRAPH SETTINGS
Selecting Graph Settings from the Options menu in graph mode allows the user to change certain features
of the display. Shown below is the settings Dialog box, to allow changes to be made to 'X' and 'Y' axes
scales, and parameter display colour. Select the parameter, in the example below this is Pressure, and
enter new maximum and minimum value for the scale. The colour can be changed by selecting Colour,
from which a set of basic and custom colours may be selected to suit.
As mentioned previously, the time axis can be changed, but this will be for all parameters displayed.
Simply select Start time and enter required date/time, then select End time and enter as appropriate.
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5.3.5

SCATTERPLOT
Speed and Direction data from a Model 108 MkIII or Model 308 can also be represented on a Scatterplot
diagram. This function is available for viewing logged data or for real time viewing. The scroll button on
the right of the display is a zoom function. This screen can also be printed by selecting Print from the File
menu.
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5.4

OPTIONS
This function allows the user to set various options as detailed below. Some functions are only available
at specific points within the software. At all times, Options allows the user to select/de-select the status
line at the bottom of the page

5.4.1

STATUS LINE
The Status line in situated at the bottom of the DataLog window. Real time data/filename and PC time and
Date are displayed here. This can be toggled on/off by selecting Status Line with the mouse.

5.4.2

CONSTANTS
Select either a UK nautical mile (1853.18 metres) or International nautical mile (1852 metres) as required
followed by OK to confirm.

5.4.3

UNITS
The units of speed can be selected as below (OK to confirm).
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5.4.4

TEST FORMULA
A feature of DataLog is its Test Formula Option. Selecting Test Formula from the Options Menu reveals
the following display, which allows the user to calculate Density Anomaly, Salinity/Conductivity, Speed of
Sound using a formula of their choice, and to perform a Depth/Pressure calculation.
The following display is revealed, and an explanation of each function is given below:

5.4.4.1 USER INPUT VALUES
CONDUCTIVITY/SALINITY
The user has the option to input either Conductivity (mS/cm) or Salinity (PSU). Click on either to
select (highlight), or click the check box. The program will calculate whichever is not input.
PRESSURE
Enter the required pressure in decibars.
TEMPERATURE
It is possible to use either IPTS-68 or IPTS-90 temperature values in the calculations. Simply click on
the desired scale or the check box to select.
LATITUDE
This is required to correct for local gravity which is required in depth calculations for Speed of Sound
[for all formulae with the exception of Chen & Millero 1977]. Enter the geographical latitude for the
measurement site, using a negative number if South of the equator.
CHANGE SPEED OF SOUND FORMULA
The user can select a formula with the Change Speed of Sound Formula button. Note that for all
formulae apart from Chen & Millero, geographical latitude must be input. Clicking the Calculate
button then reveals the Speed of Sound as calculated using the selected formula. This has no effect
on the formula used by the software for the Speed of Sound in Running Mode.
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5.4.4.2 CALCULATED PARAMETERS
The formulae used for calculating Density Anomaly γ, Salinity, Depth and Speed of Sound are given in
Appendix 1. Conductivity is calculated from Salinity using a Newton Raphson Iteration of the Salinity
formula. Salinity and Conductivity are self explanatory functions. Speed of Sound can be calculated using
various formulae, and the merits of each are discussed in Appendix 1.3. Density Anomaly γ and Depth
require further explanation:
Density anomaly γ

This is Density (ρ) - 1000

Depth

This is based on the Simple UNESCO Depth formula which is based on
assuming a salinity of 35 PSU and temperature of 0 °C. For simple
calculations of depth for different densities, the standard depth can be
corrected by multiplying it by the ratio of average density over depth of
35PSU, 0 °C water to the average density of the actual water column.
E.g.
Standard Depth [35,0] for 1000 dBar at 0 latitude = 992.117 metres
Average density [approx.] over 1000 dbar range for [35,0] seawater
= [Density at 0 dBar + Density at 1000 dBar]/2
= [1028.1 + 1032.8]/2
= 1030.45 kg/M3
Average density from data, using Data Analysis function [see section 5.3.3.1]
= 1027.6 [example number only for calculation]
Density ratio

= 1030.45/1027.6
= 1.0028

Revised depth estimate

= 992.117 * 1.0028
= 994.895 metres
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5.4.5

SPLIT SPREADSHEET
If a saved datafile is very large, the user may find it easier to split the file into a number of smaller files for
ease of analysis. If this is required, select Split Spreadsheet from the Options menu. A display similar to
that shown below will appear. Select the file to be split, and choose a new name for the smaller files. By
default, the new extensions to the smaller files will be of the form .000, .001, .002 etc.
The user is also invited to select the size of the new files (Number of Lines per File).

Each new file will have the same Header information as the original, but the fact that it is a Split
Spreadsheet will also be indicated.
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5.5

WINDOW
The Window pull down menu allows the user to configure the display to either Cascade, Tile or Arrange
Icons if showing. It should be noted however that the Brief and Full displays are not affected by this
command as they are created for display outside the DataLog window.

5.5.1

CASCADE
Below is an example of a cascaded display.
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5.5.2

TILE
Below is an example of a Tiled display.
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5.5.3

ARRANGE ICONS
Shown below is an example of the above function with a scatterplot display.
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5.6

ABOUT
To enable the user to determine which software version is operating, select the About function. A display
similar to below will be shown which contains information with regard to PC configuration.
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APPENDIX 1

DERIVED PARAMETER FORMULAE

The following extracts are taken and adapted from "Processing of Oceanographic Station Data", published
by UNESCO in 1991.

A1.1 SALINITY
The Practical Salinity Scale (PSS-78)
The fundamental step in constructing the practical salinity scale PSS-78 consisted of defining a single
reference point (S=35) on the scale as having the same electrical conductivity as a reference potassium
chloride (KCl) solution at 15°C and atmospheric pressure. The transition from the previous scale was
made by selecting a single batch (P79) of Standard Seawater and equating the new scale to the old through
the chlorinity relationship S = 1.80655 Cl for that particular batch. As the salinity on the practical scale is
defined to be conservative with respect to addition and removal of water, the entire salinity range is
accessible through precise weight dilution or evaporation without additional definitions. However, the
practical scale is defined in terms of conductivity ratio and not by its conservative properties. Thus the
second part of the definition was constructed by measuring the conductivity ratio to the KCl standard or an
equivalent secondary standard over the entire range of salinities (1 to 42) of samples prepared by
evaporation or dilution of batch P79 SSW and computing an empirical formula S = S(R15), where R15 is the
conductivity ratio 15°C and atmospheric pressure to the KCl standard. Thus salinities on the PSS-78 scale
are defined by conductivity ratios alone. Salinities determined by any other method would not necessarily
coincide with the PSS-78 scale and would have to be identified separately. Lewis and Perkin (1981) and
Mamayev (1986) discuss differences between PSS-78 and previous scales and provide algorithms and
tables to convert existing data to the new scale.
The algorithm for converting conductivity ratio to salinity is constructed in terms of the conductivity ratio R
defined as:
R = C(S, t, p)/C(35, 15, 0)
(1)
where C(S, t, p) is the electrical conductivity as a function of salinity S, temperature t and pressure p. The
ratio is factored into the functions:
R = rt(t).Rt(S, t).Rp(R, t, p)
(2)
where

rt(t) = C(35, t, 0)/C(35, 15, 0)
Rt(S, t) = C(S, t, 0)/C(35, t, 0)
Rp(R, t, p) = C(S, t, p)/C(S, t, 0)
Salinity is given by the function
5

S = ∑[ an +
n=0

∆t
1+ k ∆t

bn ]⋅ Rtn/2

(3)

with coefficients
a0 =
a1 =
a2 =
a3 =
a4 =
a5 =

+0.0080
-0.1692
+25.3851
+14.0941
-7.0261
+2.7081

b0 =
b1 =
b2 =
b3 =
b4 =
b5 =

+0.0005
-0.0056
-0.0066
-0.0375
+0.0636
-0.0144

k=
∆t =

+0.0162
t - 15

At t = 15°C (3) reduces to the formula defining the practical salinity scale (Perkin and Lewis 1980).
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The factors rt and Rp are given by

4

rt = ∑ Cn t n

(4)

0

where
C0 =
C1 =
C2 =

+0.6766097
+2.00564E-2
+1.104259E-4

and

Rp = 1 +

C3 =
C4 =

-6.9698E-7
+1.0031E-9

e1 p + e2 p 2 + e3 p 3
1 + d 1t + d 2 t 2 + ( d 3 + d 4 t ) ⋅ R
(5)

= 1+

C
B + AR

with
e1 =
e2 =
e3 =

+2.070E-5
-6.370E-10
+3.989E-15

d1 =
d2 =
d3 =
d4 =

+3.426E-2
+4.464E-4
+4.215E-1
-3.107E-3

for temperature in °C and pressure in dBar.

Given a measurement of R, t and p, salinity is computed by solving (2) for Rt; Rt = R/(rtRp) and evaluating S
from (3). If conductivity ratio R is required given S, t and p, the ratio Rt can be found by numerical
inversion of (2), and R can be found by solving the quadratic equation

R = rt ⋅ Rt ⋅ Rp = rt ⋅ Rt ⋅[1 +
or

R=

[( Ar R − B )
t

t

2

C
AR + B

]

+ 4 rt Rt A( B + C )]1/2 + [ Art Rt − B ]
2A

(6)

This description of PSS-78 has been adapted from Fofonoff (1985)
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A1.2 DENSITY ANOMALY GAMMA
Equation of State of Seawater (EOS-80)
The equation of state of seawater is the mathematical expression to calculate density from measurements
of temperature, pressure and salinity. Virtually all the computations of density of seawater made since the
beginning of the century have been based on the direct measurements of density, chlorinity and salinity
made by Knudsen, Forch and Sörensen (1902), and of compression of seawater made by Ekman (1908).
This equation was obtained from measurements of density of natural seawater in which the proportions of
the various ions are not exactly constant. To be consistent with the new definition of the Practical Salinity,
1978, the new equation of state is based on measurements of density of standard seawater solutions
obtained by weight dilution with distilled water and by evaporation. As the absolute density of pure water
is not known with enough accuracy, the density of distilled water used for these measurements was
determined from the equation of the SMOW (Standard Mean Ocean Water) whose isotopic composition is
well defined.
The new equation of state (EOS-80) which was adopted by JPOTS in 1981 (UNESCO, 1981c) is:

v ( S , t , p ) = v ( S , t , 0)[1 − p / K ( S , t , p )]

ρ( S , t , 0) = 1 / v ( S , t , 0) = A + BS + CS + DS
3/ 2

(7)

K ( S , t , p ) = E + FS + GS + ( H + IS + JS ) p + ( M + NS ) p
3/ 2

3/ 2

}

2

2

where the coefficients A, B, .....N are polynomials in temperature t. Units: salinity, PSS-78; temperature,
°C; pressure (p), bar; density (ρ), kg/m3; specific volume (v), m3/kg. These coefficients are given below.

t0
t1
t2
t3
t4
t5

A
+999.842594
+6.793952E-2
-9.095290E-2
+1.001685E-4
-1.120083E-6
+6.536332E-9

B
+8.24493E-1
-4.0899E-3
+7.6438E-5
-8.2467E-7
+5.3875E-9

C
-5.72466E-3
+1.0227E-4
-1.6546E-6

t0
t1
t2
t3
t4

E
19652.21
+148.4206
-2.327105
+1.360477E-2
-5.155288E-5

F
+54.6746
-0.603459
+1.09987E-2
-6.1670E-5

G
+7.944E-2
+1.6483E-2
-5.3009E-4

t
t1
t2
t3

H
+3.239908
+1.43713E-3
+1.16092E-4
-5.77905E-7

I
+2.2838E-3
-1.0981E-5
-1.6078E-6

J
+1.91075E-4

t0
t1
t2

M
+8.50935E-5
-6.12293E-6
+5.2787E-8

N
-9.9348E-7
+2.0816E-7
+9.1697E-10

0

D
+4.8314E-4

Density Anomaly γ is defined as the Density of the water minus 1000 kg/m3.
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A1.3 SPEED OF SOUND
The following information, discussion and conclusions are taken from Special Publication No.34 of the
Hydrographic Society, prepared by JM Pike and FL Beiboer of METOCEAN plc. The report is entitled "A
Comparison Between Algorithms for the Speed of Sound in Seawater".
The following abbreviations and units are used:
V
T
S
φ
g(φ)
Pb
Pk
D

DataLog Operation Manual

Computed speed of sound in seawater (m/s)
Temperature (°C)
Salinity
Latitude in degrees
Gravitational acceleration at the given latitude (m/s2)
Hydrostatic pressure (bar) (1bar = 105Pa = 10/g(φ) (kg/cm2)
Hydrostatic pressure (kg/cm2)
Depth (m)
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A1.3.1 STANDARD FORMULAE
A1.3.1.1

PRESSURE/DEPTH RELATIONSHIP

Several relationships are identified by Robertson(l), ranging from the approximate ("1 km of seawater
generates a pressure of 101 bar"), to the precise (use of the MacKenzie or UNESCO algorithms).
The accurate relationships require computation of the gravitational field at the latitude in question using an
appropriate formula for the gravitational field.
The UNESCO pressure/depth relationship has not been the subject of significant academic debate since its
introduction, and is stated as follows:

D=

( C1 * ( Pb * 10) + C2 * ( Pb * 10) 2 + C3 * ( Pb * 10) 3 C4 * ( Pb * 10) 4 )
+ ∆d / 9 . 8
( g ( φ ) + 12 g '* Pb )

where:
g(φ)
G'
C1
C2
C3
C4
Pb
∆d

= 9.780318 * (1.0 + 5.2788E-3 * sin2φ + 2.36E-5 * sin4φ+ )
= +2.184E-5 m.s-2. bar-1
= +9.72659
= -2.2S 12E-5
= +2.279E-10
= -1.82E-15, and
is the hydrostatic pressure (bar)
is the geopotential anomaly, expressed in J/kg. This term is zero for
standard seawater (S = 35, T = 0°C).

The geopotential anomaly term (∆d) contains the correction for the actual density distribution within the
water column, and can be evaluated for precise computation (or where there are extremes of temperature
or salinity) by integrating the specific volume anomaly over the required pressure range. The procedures
for this are also included in UNESCO Technical Paper #44.
The DataLog program, however, does not feature the ability to input ∆d (which is therefore assumed to be
0).
This assumption is recognised as being legitimate, with the resultant pressure depth algorithm called
'Simple UNESCO Depth':
D=

( C1 * ( Pb * 10) + C2 * ( Pb * 10) 2 + C3 * ( Pb * 10) 3 C4 * ( Pb * 10) 4 )
( g ( φ ) + 12 g '* Pb )

This value of D is used in all formulae within DataLog

A1.3.1.2

WOOD (1949)

V = 1410 + 4. 21 * T − 0. 037 * T 2 + 1.14 * S + 0. 018 * D

This formula was recognised before 1960 as being inadequate, and was replaced (at least in US Navy
Hydrographic Office operations) in 1962 by the Wilson formula. It is thus not used in DataLog.

DataLog Operation Manual

Page 34

0300844A.DOC

Valeport Limited

A1.3.1.3

WILSON (OCTOBER 1960)
Full Version

The full version of this formula is:
V = 1449.14 + VT + V P + VS + VSTP , where
VT = 4. 5721 * T − 4. 4532 E − 2 * T 2 − 2. 6045 E − 4 * T 3 + 7. 9851E − 6 * T 4
V P = 1. 60272 E − 1 * Pk + 1. 0268 E − 5 * Pk2 + 3. 5216 E − 9 * Pk3 − 3. 3603 E − 12 * Pk4
VS = 1. 39799 * ( S − 35) + 1. 69202 E − 3 * ( S − 35) 2
VSTP = ( S − 35) * ( −1.1244 E − 2 * T + 7. 7711E − 7 * T 2 + 7. 7016 E − 5 * Pk − 1. 2943 E − 7 * Pk2 + 3.1580 E − 8 * Pk * T + 1. 5790 E − 9 * Pk * T 2 )
+ Pk * ( −1. 8607 E − 4 * T + 7. 4812 E − 6 * T 2 + 4. 5283 E − 8 * T 3 )
+ Pk2 * ( −2. 529 E − 7 * T + 1. 8563 E − 9 * T 2 )
+ Pk3 * ( −1. 9646 E − 10 * T )

Wilson states that the formula is valid to within ± 0.3 m/s in the ranges:
-4°C < T < 30°C; 0 < S < 37 1 kg/cm2; < Pk < 1000 kg/cm2.
where Pk = Pb ⋅

10
g (φ)

Simplified Version
A simplified version of this formula, which is believed to have been used for a number of offshore surveys,
is:
V = 1. 449.14 + 4.5721 * T − 4. 4532 E − 2 * T 2 − 2. 6045 E − 4 * T 3 + (1. 39799 − [1.1244 E − 2 * T ]) *( S − 35) + 1. 643 E − 2 * D

The range of validity is likely to be comparable to the full version, with simplification (and inaccuracy)
introduced by replacing the pressure terms with a depth term (of unknown provenance), and ignoring 4th
order temperature terms (inter alia).
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A1.3.1.4

MEDWIN (1975)

This simple formula was based on the Del Grosso equation and is:
V = 1449. 2 + 4. 6 * T − 0. 055 * T 2 + 0. 00029 * T 3 + (1. 34 − 0. 010 * T ) * ( S − 35) + 0. 016 * D

Medwin states the formula is valid "for realistic combinations of T, S, P" in the ranges 0 < T < 3S°C,
0 < S < 45, 0 < D < 1000 m. The fact that the equation was based on the Del Grosso equation, however,
leads to the conclusion that the range of validity cannot be superior to the Del Grosso formula itself, which
is deemed to be valid only in a limited temperature and salinity range.
The more likely validity of the Medwin formula is indicated in the matrix below, in which the maximum
valid pressure (in bar) is indicated for each temperature and salinity:

T (°C)
S

0

5

10

15

33
34
35
36
38

100
100
100
100
69

100
100
100
100
69

100
100
100
100
100

69
100
100
69
100
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A1.3.1.5 CHEN AND MILLERO (1977)
This formula was adopted by UNESCO in 1983 and is as follows:

V = Cw ( t , p )+ A( t , p ). S + B( t , p ). S 3/ 2 + D( t , p). S 2
where,

CW ( t , p) = C00 + C01 . T + C02 . T 2 + C03 . T 3 + C04 . T 4 + C05 . T 5 +
( C10 + C11 . T + C12 . T 2 + C13 . T 3 + C14 . T 4 ). Pb +
( C20 + C21 . T + C22 . T 2 + C23 . T 3 + C24 . T 4 ). Pb2 +
( C30 + C31 . T + C32 . T 2 ). Pb3
A( t , p) = A00 + A01 . T + A02 . T 2 + A03 . T 3 + A04 . T 4 +
( A10 + A11 . T + A12 . T 2 + A13 . T 3 + A14 . T 4 ). Pb +
( A20 + A21 . T + A22 . T 2 + A23 . T 3 ). Pb2 +
( A30 + A31 . T + A32 . T 2 ). Pb3
B ( t , p ) = B00 + B01 . T + ( B10 + B11 . T ). Pb
D( t , p ) = D00 + D10 . Pb
with the coefficients defined in the following matrix:

Subscript

A

B

C

D

00
01
02
03
04
05
10
11
12
13
14
20
21
22
23
24
30
31
32

+1.389
-1.262E-2
+7.164E-5
+2.006E-6
-3.21E-8

-1.922E-2
-4.42E-5

+1.727E-3

+9.4742E-5
-1.2580E-5
-6.4885E-8
+1.0507E-8
-2.0122E-10
-3.9064E-7
+9.1041E-9
-1.6002E-10
+7.988E-12

+7.3637E-5
+1.7945E-7

+1402.388
+5.03711
-5.80852E-2
+3.3420E-4
-1.47800E-6
+3.1464E-9
+0.153563
+6.8982E-4
-8.1788E-6
+1.3621E-7
-6.1185E-10
+3.1260E-5
-1.7107E-6
+2.5974E-8
-2.5335E-10
+1.0405E-12
-9.7729E-9
+3.8504E-10
-2.3643E-12

+1.100E-10
+6.649E-12
-3.389E-13

-7.9836E-6

The Chen & Millero expression is based upon comprehensive observations on seawaters in the ranges
0<T<40°, 0<S<40, 0<Pb<1000. Some concern has been expressed, however, at the accuracy of the
formula at pressures exceeding 100 bar.
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A1.3.1.6 DEL GROSSO (1974)
V = C000 + DCT + DCS + DC P + DCSTP , where
C000
= 1402. 392

DCT

= 0. 501109398873 E + 1 * T − 0. 550946843172 E − 1 * T 2 + 0. 221535969240 E − 3T 3

DCS

= 0.132952290781E + 1 * S + 0.128955756844 E − 3 * S 2

DC P

= 0.156059257041 * Pk + 0. 244998688441E − 4 Pk2 − 0. 883392332513 E − 8 * Pk3

DCSTP

= −0.127562783426 E − 1 * T * S + 0. 635191613389 E − 2 * T * Pk
+ 0. 265484716608 E − 7 * T 2 * Pk2 − 0.159349479045 E − 5 * T * Pk2
+ 0.522116437235 E − 9 * T * Pk3 − 0.438031096213 E − 6 * T 3 * Pk
− 0.161674495909 E − 8 * S 2 * Pk2 + 0. 968403156410 E − 4 * T 2 * S
+ 0. 485639620015 E − 5 * T * S 2 * Pk − 0. 340597039004 E − 3 * T * S * Pk

The formula is deemed to be valid only in the temperature and salinity ranges, and up to the pressures
(bar), indicated in the matrix below:

T (°C)
S

0

5

10

15

33
34
35
36
38

1034
1034
1034
1034
69

1034
1034
1034
1034
69

275
207
414
275
414

69
207
207
69
414

DataLog Operation Manual

Page 38

0300844A.DOC

Valeport Limited

A1.3.1.7 MACKENZIE (1981)
Based upon widespread oceanographic measurements, the MacKenzie formula is:
V = 1448. 96 + 4. 591 * T − 5. 304 E − 2 * T 2 + 2. 374 E − 4 * T 3
+ 1. 340 * ( S − 35) + 1. 630 E − 2 * D + 1. 675 E − 7 * D 2
− 1. 025 E − 2 * T * ( S − 35) − 7.139 E − 13 * T * D 3

and is stated to be valid for naturally occurring seawaters in the intervals indicated in the matrix below:

Pk

T (°C)

S

0
50
100

0-30
0-20
0-14
0-16
10-16
0-12
0-16
8-16
0-5
12-14
0-5

30-40
32-40
32-34
35-38
39-40
32-36
37
38-39
33-36
38-39
34-35

200

500
800
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A1.3.2 DISCUSSION
A1.3.2.1

DEVELOPMENT OF FORMULAE

A useful overview of the history of seawater speed of sound measurements and formulae is provided by
Dulshaw et al.
All formulae given above (and the majority of others referred to in the course of this study) were
empirically derived from measurements of acoustic velocity of seawater samples whose temperature,
salinity and pressure were measured in the oceans and/or varied in the laboratory. The Robertson equation
is one of the few attempts to base the equations for the speed of sound on theoretical considerations alone.
The Wood formula, while in use even now, wass considered as early as 1960 to be unreliable for the
advancing technology and requirements of that era, and was superseded by the Wilson formula in 1961.
The recognition of defects in the experimental methods of Wilson, together with the adoption of the
practical salinity scale and the international equation of state for seawater (EOS-80) resulted in the Wilson
formula being superseded for oceanographic purposes by the Chen & Millero formula, which still
represents the formal standard for oceanographic purposes.
The limitations of the Chen & Millero formula in turn were revealed by precise in situ observations of
acoustic velocity with depth, and by the advent of tomographic methods to determine seawater physical
properties along very large path-lengths (across oceans) and to great depths.
These observations have led in recent years to the realisation that the Chen & Millero formula has distinct
limitations at high pressures, and that the Del Grosso equation may be more realistic for such specialist
purposes. The wide validity range for salinity and temperature of the Chen & Millero formula is of value
for measurements on the continental shelf, however. The quality of fit of the Del Grosso equation to the
modern high-pressure data sets (and the corrections that should consequently be applied to the Del Grosso
equation) is currently the subject of some debate.

A1.3.2.2

COMPARISON OF FORMULAE

The Wood and Wilson formulae do not fit modem experimental and observational data well, and should
no longer be used for precise computations. This probably is the result of improvements in observational
and analytical techniques over the years, together with changes in computational methods of salinity and
depth.
The remaining algorithms show fairly close agreement with one another, diverging as pressure increases.
The Chen & Millero formula is commonly accepted for oceanographic use, and was derived from
measurements over a wide salinity, temperature and pressure range.
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At high pressures (>100 bar), however, recent research suggests that the Del Grosso equation is more
accurate, although this formula is valid only for a limited range of oceanic waters.
The Del Grosso formula has been used as a benchmark to appraise the accuracy of the other algorithms.
The following order of preference is suggested:
i)
ii)
iii)
iv)

Chen & Millero (only for water depths less than 1000m)
Del Grosso (only for water depths greater than 1000m)
MacKenzie (for rapid computations in oceanic waters to 8000m water depth)
Medwin (for rapid computations in oceanic waters to 1000m water depth)

The Medwin and Wilson (simplified) formulae diverge considerably from the remaining algorithms at
temperatures greater than 20°C. This is expected from two simple formulae lacking higher order
temperature terms.
There may be some advantages in using the MacKenzie and Medwin formulae where depth is known, and
where the computation of pressure for inclusion in the Chen & Millero or Del Grosso formulae would
become unnecessarily onerous. The user should be made aware, however, of the limited range of
conditions of temperature, salinity and pressure over which these formulae are valid.

A1.3.2.3 THE PRESSURE/DEPTH ALGORITHM
An accurate expression for computing pressure from depth (and vice versa) may be desirable:
a)

for its own sake, to enable precise pressure and depth computations to be made for a variety of
purposes; and

b)

to enable precise speed of sound computations to be made.

When using speed of sound algorithms with a pressure term (Chen & Millero, Del Grosso), the water
pressure can be measured directly, estimated from a known depth and inversion of the UNESCO
pressure/depth algorithm (possibly based on a carefully calibrated conductivity/temperature/depth cast), or
calculated from standard tables. According to Saunders and Fofonoff, who were the originators of the
basic method adopted in the UNESCO formula, these estimates should be carried out at 5 bar pressure
intervals near the surface and at 200 bar intervals for greater depths.
When using speed of sound formulae with a depth term (MacKenzie or Medwin), the depth may be
estimated or measured by some independent means; or computed from a pressure measurement and a
conductivity/temperature depth cast. It is more likely, however, that these methods would not be used for
precise purposes; they are in any case valid only for oceanic waters in which the errors in the estimation
of depth, introduced through ignoring the geopotential anomaly, would not be excessive.
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A1.3.3 CONCLUSIONS
1. It is recommended that use of the Wood and Wilson formulae be discontinued for precise purposes, as
they do not provide good agreement with modern data sets and computational methods of salinity and
depth.
2. It is of crucial importance to ensure that the formulae (of whatever origin) are used only for
observations made within the ranges of temperature, salinity and pressure for which each expression is
deemed valid.
3. It is recommended that the Chen and Millero formula be used for seawaters on the continental shelf.
This incorporates a pressure term which should be measured directly; evaluated from a known depth
using the full UNESCO formula and data obtained either from oceanographic tables or from a
conductivity/temperature/depth cast; or the error in using the simplified UNESCO formula deliberately
accepted.
4. In deep ocean waters, the Del Grosso formula is currently favoured, especially for long path-lengths.
This also uses a pressure term.
5. Where rapid computations are necessary, or where the depth is known (but not pressure), the simple
MacKenzie (9 terms) and Medwin (5 terms) formulations may prove of value. These expressions are
strictly valid only for normal oceanic waters. Where depth is computed from pressure, the simplified
UNESCO equation for the pressure/depth relationship could be used without introducing significant
error.
6. Incorporation of the full UNESCO pressure/depth algorithm (incorporating the geopotential anomaly)
would be a useful addition to any software package, although there may be little discernible benefit to
the accuracy of the speed of sound computations. The complete formula would, however, enable a
full suite of precise applications to be available for use worldwide.

DataLog Operation Manual

Page 42

0300844A.DOC

